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Installing This Update
The latest version of EasyCatalog can be installed using the 
installer that can be downloaded from our web site:

http://www.65bit.com/downloads/downloadpre.shtm

Workspace Folders

The format of the EasyCatalog workspace folder has not 
changed since version 2.1.x of EasyCatalog.  Therefore, 

any data sources created since version 2.1 of EasyCatalog 
will also open in EasyCatalog versions 3, 4 and 5.

Workspace folders created in EasyCatalog for InDesign 
CS1 will not open in the CS3, CS4 and CS5 versions of 
EasyCatalog and must be re-created.  Provided the data 
source name, key fields and field names remain the same 
any existing documents should remain linked to the new 
data source.

These Release Notes detail the changes made to 
EasyCatalog since the previous version and may include 
details of new functionality that is not yet included in the 
main EasyCatalog User Guide.  

Maintenance releases of EasyCatalog will also include 
a number of bug fixes, so it is a good idea to check that 
you’re always running the latest version of EasyCatalog 

using the ‘Check for Updates’ button on the ‘About 
EasyCatalog’ dialog.

Release Notes for previous versions can be found here: 
http://www.65bit.com/downloads/easycatalog/files/CS3/
Previous Release Notes.pdf

Version 5.0.4/5.5.4	 17 October, 2011

Enhancements
EasyCatalog
•	 A new Field Option has been added that allows a field to 

be nominated that contains either the name of a swatch 
or an RGB value of a colour to apply to an image. RGB 
values should be prefixed with a #.

 
� [601]

•	 Added new Field Option to support the embedding of 
formatting tags as hidden InDesign conditional text.  
This allows the panel to later be updated whilst retaining 
the formatting tags.  

	 EasyCatalog will create InDesign Conditional Text called 
‘EC-Formatting-Hidden’ and ‘EC-Formatting-Visible’ 
to store both the original formatting tags and their 
equivalent document content (in the case of character 
entities).  

The EC-Formatting-Hidden Conditional Text will contain 
formatting tags such as <b> and entities such as 
&nbsp;. The EC-Formatting-Visible Conditional Text is 
used to store the converted character entities.� [599]

•	 Serial number entered by user is now cleaned-up before 
validation by stripping invalid characters or replacing 
characters commonly confused characters.� [583]

•	 Added new option has been added to ‘Adopt Fields’ 
to specify whether new records should be marked as 
‘Inserted’ or ‘Deleted’ in the panel.� [586]

•	 Added support for the \U operator on regular expression 
back-references. 
REGEX(FIELDSTR(field a),'̂ (...)(...)(..)','\L\1-\U\2-\U\3')

� [620]

•	 If ‘Flag Empty Pictures as Errors’ is set the replacement 
image will be imported for empty picture fields; if it is not 
set the replacement image will not be imported.� [621]

•	 The HTML parser has been improved so that if an HTML 
entity cannot be found in the current font, alternative 
fonts will be searched for the glyph.� [638]

Upgrading from Previous Versions

About This Document

AS WITH ANY SOFTWARE UPGRADE, ALWAYS BACKUP YOUR EASYCATALOG WORKSPACE 
FOLDER AND DOCUMENTS PRIOR TO INSTALLING THE LATEST VERSION. !
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•	 More characters have been added to the ‘Ignore White 
Space changes’ list.  “Page Number” and “Index Marker” 
characters which have been inserted should now be 
ignored.� [639]

•	 The ‘Edit Field Content’ dialog is now bigger.� [672]

•	 Field Options for multiple fields can now be edited at 
once.  Alt-click on the column headers to select the 
fields to be edited, then use the right-click contextual 
menu to edit the Field Options.  Note that all settings 
shown in the Field Options dialog will be copied to all 
of the selected columns, not just the settings that have 
been modified.

Custom Fields
•	 Custom fields can now be identified in the panel by the 

‘function’ icon in the column header. � [613]

•	 New option added to the Custom Field Field Option’s 
pane: ‘Automatically Update Content’.  When this is 
turned off the content of this custom field will only be 
updated when using the ‘Update Selected Custom Fields’ 
right-click menu option.�

•	 New custom field command ‘SUB’ to subtract each 
parameter from the previous.� [591]

•	 XREFFIELD custom field function can now search for 
fields containing the specified string, or fields starting or 
ending with the specified string.  
Prefix and suffix the ‘search for’ string with ‘%’ to 
search for a field ‘containing’ the specified text (e.g. 
‘%findme%’).
Prefix the ‘search for’ string with ‘%’ to search for a field 
starting with the specified text (.e.g ‘findme%’)
Suffix the ‘search for’ string with ‘%’ to search for a field 
end with the specified text (.e.g ‘%findme’)� [625]

•	 An optional fourth parameter has been added to 
‘XREFFIELD’ custom field function to allow a data source 
name to be specified.  This allows field content from 
another data source to referenced. When using this 
custom field, ‘Synchronize with Data Source’ will also 
synchronize data sources referenced by this command.
� [626]

•	 ‘GROUPLIST’ custom field function now has an optional 
last parameter which specifies whether only unique 
values are returned (default) or whether all values should 
be returned.� [634]

Images and Image Previews
•	 Images can now be previewed in the EasyCatalog data panel by hovering over the 

image field in the panel.   

To see image previews in the panel:

•	 �Ensure that ‘Text and Image Previews’ is selected in the Panel Preferences. To 
access the “Panel Preferences” dialog right-click in the data area of the panel and use the “Panel Preferences” 
menu option from the contextual menu that appears.

•	 �Only fields that have a ‘Content Location’ specified will show image previews.  If your data contains a full path 
to the image, you must still ensure that you configure a path in the Field Options. This path will be ignored for 
the purposes of importing the images.

•	 �Images imported from a URL will only have previews available when the images have been downloaded 
and cached locally.  Images will be cached locally after initial placement in a document or after using the 
“Images → Download All” menu option from the data panel’s pop-out menu.

•	 Multiple images can now be stored in a single field within EasyCatalog, 
and the one to use during placement or pagination can be selected in the 
panel.

•	 Images should be separated by a carriage return in the source data.
•	 When hovering over an image field containing multiple images, all 

images will be previewed. The image to use when importing this field can be selected by clicking on the preview.
•	 This functionality is not supported when importing images from URLs.

•	 Image previews can be dragged and dropped to the document.  The image will be imported and linked to the field 
in the panel.

•	 Image previews are now visible in the Record Viewer panel and in the main EasyCatalog data panel.� [656]
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•	 New custom field command 
‘GOOGLEQRCODEURL’ which will call 
the Google Charts API to generate a 
QR code with the given content.  This 
function call can be used in the Picture 
Options on the Field Options dialog.
GOOGLEQRCODEURL(500,500,'Hello')

	 The Google Charts API has a maximum width and height 
specification of 500 pixels.� [651]

•	 New custom field command ‘URLENCODE’ which will 
URL-encode the given string.  This function should be 
used when building URLs, when importing images for 
example.
URLENCODE(FIELDSTR('myfield'))

� [652]

•	 New custom field command ‘URLDECODE’ which will 
URL-decode the given string.  
URLDECODE(FIELDSTR('myfield'))

� [653]

•	 New custom field command ‘NOT’ which will return the 
boolean opposite of what was passed in.
NOT(IF(LENGTH(FIELDSTR('myfield')),'<',10))

� [660]

•	 Added support for UPC-A barcodes which can be 
generated using the CarolinaBarUPC font.� [582]

•	 New custom field command ‘DECTOFRAC’ which will 
attempt to transform a decimal value into a fraction - 
e.g. 0.25 = 1/4.
DECTOFRAC(FIELDSTR(field a))

� [642]

•	 Added new custom field command ‘SNIPPETDEPTH’.  
This function will populate the given snippet with the 
contents of each record and return the depth of it in 
points.

This function will be useful for instances where it may 
be requried to calculate how many records can fit on a 
page, for example.  For performance reasons turn off 
the ‘Automatically Update Content’ option on the Custom 
Field Field Options pane.
SNIPPETDEPTH("Macintosh HD:My Snippet.idms")

•	 Perfomance improvement when evaluating custom 
fields.�

EasyCatalog Pagination Module
•	 A new continuation type of ‘Grow and Flow’ has been 

added. This item will be used when the text box has 
been extended to the bottom of the page and it needs to 
continue on the following page.� [600]

•	 During guide-based pagination, if there’s a custom field 
called ‘paginationFirstOnPage’ it will be populated with 
‘yes’ when paginating the first item on the page.  This 
can be referenced in Pagination Rules Actions.� [628]

•	 A new option has been added to the ‘Paginate’ dialog 
to specify whether the Pagination operation should be 
undo-able.  Turning this off should significantly improve 
responsiveness after pagination completes.� [635]

•	 Modification to the ‘matrixtable’ script label to enable 
data to be filtered. 
<filter field="fieldname" value="value"/>

	 This should be included in the <fields> or <columns> 
node.� [635]

•	 ‘matrixtable’ script label now supports header columns 
at the right of the table which will remain fixed.
<matrixtable headercolumnsonright="2"/>

� [604]

•	 When determining whether Product Styles fit on the 
page, guide-based pagination should be a little less 
precise. Previously it would be determined that an item 
wouldn’t fit if it was a fraction of a point over.� [630]

•	 New option added to the ‘Using Master Pages’ 
pagination type to specify the grouping level in the 
panel to paginate at.  For example, it’s now possible to 
paginate specific groups into each position on the page/
spread.� [630]

EasyCatalog Scripting Module
•	 Add new method to data view object to show a list of 

specific records by passing an array of keys: 
var myKeys = new Array();
myKeys[0] = "300-001"; 
myKeys[1] = "300-002";
myKeys[2] = "300-003";
myDV.showRecords(myKeys);

� [592]

•	 The ‘fieldContent’ property is no-longer read-only and 
can be modified using scripting.� [617]
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•	 A new scripting call has been added to save the local 
data snapshot to the workspace folder.  This should be 
called, for example, after modifying field content. 
myDS.save();

� [619]

•	 A new scripting call has been added to ensure custom 
field content is up-to-date.   
myDS.updateCustomFields();

� [619]

Bug Fixes
The following bugs have been fixed in this release of EasyCatalog.  For clarity, the bug reports listed below show the original 
problem as reported.  It is often not possible to detail the fix for each issue as they involve internal changes to EasyCatalog.

EasyCatalog
•	 EAN8 check digit is not always calculated correctly 

when using the ‘EAN8’ custom field function.� [579]

•	 Crash attempting to validate an image path that contains 
double colons (‘::’).  This affects Macintosh CS4 only.	
� [581]

•	 If a field is set to ‘Imported Text’ from ‘Field Content’, 
the content is only being inserted when a new field is 
inserted into the document and not during drag ‘n’ drop.
� [587]

•	 Update Panel is not updating picture paths in the panel.	
� [599]

•	 ‘Cell Finder’ and ‘Auto Pickup’ crash intermittently.� [607]

•	 Table columns do not always merge vertically.� [580]

•	 ‘Imported Text’ not showing as ‘in error’ if the file cannot 
be loaded.� [588]

•	 Empty fields that are set as ‘Imported Text from Field 
Content’ are showing as ‘in error’ after placement.� [589]

•	 LEFTSTR and RIGHTSTR commands fail if the length 
given is greater than the length of the field.� [596]

•	 Some of the panel icons are missing when running 
under InCopy.� [602]

•	 ‘Show Subset’ not working for fields that are set 
as ‘Imported Text’.  The wrong set of operators are 
displayed in the ‘Show Subset’ dialog.� [623]

•	 ‘Synchronize with Data Source’ is slow when the 
structure of the file changes.� [624]

•	 Potential crash when using \L and \U back-reference 
operators.� [636]

•	 Page hyperlinks sometimes produce invalid hyperlinks.
� [637]

•	 Automatic key generation not working on Windows. 
Holding Shift and Alt when pressing ‘OK’ on the File 
and ODBC Data Source configuration dialogs will add 
a custom field and automatically generate a key for 
each record.  This should be used with extreme caution, 
however, as it may not be possible to later update data 
placed using this generated key.� [662]

•	 All configurations on the ‘Configurations’ menu 
sometimes have check mark against them. Only the 
configurations applied to the panel should be checked.
� [657]

•	 Table column resizes too small when it contains 
formatted text.  This occurs when using the ‘Fit to 
Content’ column option.� [664]

•	 Table column resizes too small when it has a stroke 
applied. This occurs when using the ‘Fit to Content’ 
column option.� [665]

•	 ‘Update Panel with Page Numbers’ is slow when using 
‘Collate pages for all grouped records’.� [666]

•	 Too many nodes were created in the reports XML which 
could lead to crashing.� [611]

•	 In Field Options, if the replacement parameter for a 
cleansing option contained a custom field function, the 
‘seach-for’ argument for the cleansing option would be 
inserted into the output string instead of the result of the 
function.� [658]

•	 Table cell merging does not always ignore hidden 
characters which therefore prevents the table cell from 
merging.� [659]

•	 When data panels are docked but hidden, they will not 
synchronize with the front-most document when shown 
for the first time.� [671]

•	 Horizontal table population sometimes crashes.� [669]

EasyCatalog FIle Data Provider
•	 No parse errors are being displayed. � [641]

•	 No error is being reported for corrupt UTF-8 files. � [640]

EasyCatalog ODBC Data Provider
•	 Temporary fix which should prevent crashing when using 

the Actual SQL Server ODBC driver. � [645]

EasyCatalog Pagination Module
•	 Frame fitting does not resize the box deep enough when 

‘First Baseline’ text frame setting is applied. � [644]

•	 The fitting option ‘Frame Depth to Field Depth’ should be 
performed before the content of the box is resized. � [594]

•	 The ‘Continuation’ pagination type is not working with 
Grow and Flow pagination.� [600]

•	 Box fitting functions will sometimes move the box.� [584]

•	 ‘Unhandled exception in ECAutoPageInserter.cpp at line 
240’.� [593]

•	 Guide-based pagination placing Product Style at wrong 
location on page when document has a slug area.� [631]

•	 Memory leak when populating tables horizontally.� [650]
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•	 The fitting option ‘Frame Depth to Content Depth’ 
sometimes affects the width of the box.� [654]

•	 Incorrect library item being chosen during pagination. 
If the library contains a wildcard item (‘*’), this may be 
chosen even though there may be an item with a name 
that matches the nominated field.� [590]

•	 ‘Field not found’ error when using Pagination Rules 
Actions on a Relational data source group that has no 
records.� [608]

•	 The wildcard library item may not be chosen for group 
items when using the ‘Asset Name’ pagination option.
� [609]

•	 ‘Remove Blank Lines for Empty Fields’ not working if 
there’s an empty anchored picture box.� [615]

•	 A guide placed on the page edge is not being detected 
by guide-based pagination.� [629]

•	 Text-on-a-path items sometimes disappear.� [670]

EasyCatalog Scripting Module
•	 Updating the page numbers via the script call is not 

saving the local data snapshot in the workspace folder.
� [612]

•	 ‘applyConfiguration’ call does not always work.  If the 
name of the data source view is not the same as the 
data source, applyConfiguration will fail to find the 
configuration to apply.� [633]

•	 ‘dataView.selectedRecords()’ is returning a view that 
cannot access its records.� [632]
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Version 4.0.5 / 5.0.3	 8 March, 2011

Enhancements
EasyCatalog
•	 A new option is available on the right-click contextual 

menu: ‘Clear Update Flags’. This new option will remove 
the ‘updated’ status from the selected record(s).	 [469]

•	 512 fields can now be displayed on the Field Specifiers, 
Field Options and Show/Hide Fields  menus.	 [470]

•	 A new keyboard shortcut has been added - ‘Replace 
Fields In Selection’ which will show the EasyCatalog 
‘Replace’ dialog but only replace the fields in the 
document selection.	 [498]

•	 Added support for the <SMALL> HTML tag.	 [503]

•	 Added new contextual menu option to allow field 
content to be edited within EasyCatalog.  Right-click on 
the field to edit and select ‘Edit Field Content’	 [512]

•	 When using the ‘Adopt Fields’ menu option, any records 
that are present in the document but not in the data 
source being adopted to can now be added to the 
panel. Any records added to the panel will be shown as 
‘deleted’.	 [516]

•	 Fields that have been updated in the data source are 
now shown with a yellow dotted outline when the 
background colour of the field is red.	 [536]

•	 The EasyCatalog workspace folder can now be 
organized into sub-folders. These sub folders are now 
displayed in the ‘File → New → EasyCatalog Panel’ 
menu.	 [538]

•	 If the structure of a data source changes, EasyCatalog 
will now show the differences between the old and the 
new.  Previous versions would load a fresh copy of the 
data and not highlight the changes.	 [540]

•	 Added mouse scroll wheel support for the Record 
Viewer Panel and the Group dialog.	 [542]

•	 User-interface elements of EasyCatalog can 
now be suppressed (disabled) or hidden using a 
‘SuppressedUI.xml’ file in the root of the EasyCatalog 
workspace folder.

<?xml version=”1.0” encoding=”UTF-16” standalone=”yes”?>
<SuppressedUI>
<SuppressedAction actionID=”576521” restrictionType=”hide”/>
<SuppressedAction actionID=”576565” restrictionType=”hide”/>
</SuppressedUI>

	 [xxx]

Record Viewer Panel
•	 Added support for literal (exact match) searching in the 

Record Viewer panel.  Entering the search term in single 
quotes will only show records where the entire field 
content matches the search term entered.	 [499]

•	 Searches are now case insensitive in the Record Viewer 
panel, unless a literal search is being performed.	 [500]

•	 When searching in the Record Viewer panel, the 
highlighted search result is now horizontally scrolled into 
view.	 [501]

•	 Added ‘Key Fields’ search option to the Record Viewer 
panel to allow the user to search the content of only the 
key fields.	 [504]

Custom Field Functions
•	 Support has been added for the EanT48L barcode font. 

The EAN13/EAN8 custom field functions have been 
modified to accept an optional second parameter which 
specifies the glyphs to use:

EAN13(FIELDSTR(code), GETBARCODEGLYPHS('EanT48L'))

 	 [483]

•	 Added ‘COUNTOF’ custom field function which returns 
the number of instances of one string in another.

COUNTOF('Apple', 'p')

	 [484]

•	 When using regular expressions, the contents of back 
references can now be converted to lower case by 
prefixing the back reference with \L:

REGEX:(.+?<small>)(.+?)(</small>)=\1\L\2\3;

	 [488]

•	 Added ‘INDEXOF’ custom field function which returns 
the character index of one field within another.

INDEXOF(FIELDSTR('Manufacturer'), 'Apple')

		  [492]

•	 Added ‘LENGTH’ custom field function which returns the 
length of the given string.

LENGTH(FIELDSTR('Body Copy'))

	 [493]

•	 Added ‘LASTINDEXOF’ custom field function which 
returns the character index of the last instance of one 
string within another.

LASTINDEXOF(FIELDSTR('Body Copy'), 'Apple')

	 [494]

•	 Added support for InDesign metacharacters in custom 
field function parameters.

INDEXOF(FIELDSTR('Manufacturer'), '̂ p')

		  [495]

•	 Added ‘XREFFIELD’ custom field function which 
searches returns the contents of another record’s fields.

XREFFIELD('PartNbr',FIELDSTR('XrefPartNbr'),'PageNbr')

	 [531]
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•	 Added ‘GROUPXREFFIELD’ custom field function which 
searches returns the contents of another record’s fields 
within the same group as the record.

GROUPXREFFIELD('Parent Group:Child Group', 'PartNbr',F

IELDSTR('XrefPartNbr'),'PageNbr')

	 [546]

•	 Added ‘GROUPNUMBERSEQUENCE’ custom field 
function which creates a comma separated list of 
numbers in the specified field in ascending order. 
Contiguous ranges are shown as nnn-nnn.

GROUPNUMBERSEQUENCE('Parent Group:Child 

Group','TOC _ PageNumber')

	 [555]

•	 Added ‘GETNTHPOPULATEDPARAM’ custom field 
function which returns the n’th populated parameter.

GETNTHPOPULATEDPARAM(0,FIELDSTR('

Small _ Price'),FIELDSTR('Medium _

Price'),FIELDSTR('Large _ Price'))

	 [565]

EasyCatalog Pagination Module
•	 Specifying a ‘Position Index’ of ‘ALL’ will copy and repeat 

the contents of a text box once per record in the group 
being paginated.	 [548]

•	 Added new Frame Fitting option - ‘Frame Content Depth 
and Width’ which will adjust the width and height of the 
frame to fit the content (in the same manner as double 
clicking the bottom-right control point of the text frame).

	 [560]

•	 Added new Pagination Rule - ‘Fitting Anchor Point’ - 
which specifies the anchor point to use when frame 
fitting.  For example, specifying an anchor point of 
‘bottom center’ will resize the top of the box down until 
the text fits.	 [570]

•	 A new pagination option is available (which can currently 
only be set via a scripting call or by manipulating 
‘Pagination.xml’ in the EasyCatalog workspace folder) 
which forces ‘Position Based’ pagination to paginate 
the product styles in the position specified (rather than 
populating the product style and then moving it to the 
specified co-ordinates).	 [572]

•	 Columns can now be excluded from the ‘Restrict Vertical 
Cell Merging to Page Bounds’ function by highlighting the 
table column and specifying the following in the ‘Script 
Label’ dialog:

keepmergedcellstogether

	 [547]

•	 Right/CTRL click support added to Pagination Rules 
panel to set pagination options.

•	 Scroll-wheel support added to Pagination Rules panel.

EasyCatalog Scripting Module
Added new ‘Remove Field Markers’ scripting call. 
var myEasyCatalog = app.easycatalogObject;

var myDoc = app.activeDocument; 

myEasyCatalog.removeFieldMarkers(myDoc); 

	 [312]

•	 An optional parameter has been added to the LoadFile 
call to specify the encoding type.

var myDS = myEC .loadFile(“my data source”, 

“Macintosh HD:utf8file.csv”, “,”, “LF”, “key”, 

“UTF8”);

	 [513]

•	 Added an optional parameter to the 
‘paginateUsingDefaults’ call to specify the document to 
use.	 [568]

•	 Added new scripting call to specify field options. 
The parameters are: field name, option name, option 
value. The option name is the same as specified in the 
‘Fields.xml’ file.

myDS.setFieldOption(“Make”, “prefix”, “xxxx”);

	 [514]

Bug Fixes
EasyCatalog
•	 Regular expression back references would sometimes 

insert the wrong characters.	 [472]

•	 Crash when using group custom field commands with a 
field that does not exist.	 [474]

•	 Picture import would always add the file extension even 
if it was already present in the field content.	 [475]

•	 Field definition files from the CS1 version would not 
import on Intel Macintoshes.	 [478]

•	 Empty image fields not importing the replacement 
image.	 [482]

•	 Placed status not updating correctly when dragging a 
populated library item or snippet to the document.	 [489]

•	 Custom fields that do not have a function specified are 
not being formatted (prefix, suffix, etc).	 [490]

•	 Custom fields that do not have a function specified 
cannot be used as a parameter to other custom fields.

	 [491]

•	 Empty strings should evaluate to ‘0’.	 [496]

•	 Carriage returns, new lines and tabs should be replaced 
by spaces when displaying field content in the record 
viewer panel.	 [502]
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•	 Insertion of Field Specifier is losing character styles 
applied to the text. This only occurs when text is 
selected in the document whilst inserting a field 
specifier.	 [505]

•	 Update Furniture using the first item on the page will 
sometimes use the last item from the previous page.	[506]

•	 ‘Occurred’ is spelled incorrectly in the product 
registration error messages.	 [509]

•	 “Exclude from Document Updates” and “Exclude from 
Data Source Updates” renamed to “Exclude from Update 
Document” and “Exclude from Update Panel”.

	 [510]

•	 Unable to create a new data source if a data source of 
the same name is displayed in the Record Viewer panel.

	 [515]

•	 Column header icons are displayed in the wrong 
position.	 [517]

•	 Insertion of a field is losing the character styles applied 
to the text.  This only occurs when text is selected in the 
document prior to inserting the field.	 [518]

•	 ‘Update Document’ is dirtying the document when no 
fields have been updated.	 [519]

•	 File → New → EasyCatalog Library dialog is defaulting 
to a location inside of the InDesign application package 
(Macintosh only).	 [520]

•	 Fields for records marked as deleted should be shown 
as ‘in error’. Records marked as deleted that contain 
placed fields should also appear in advanced query 
results for ‘error’ records.	 [521]

•	 Corrupted path after using folder chooser on Windows 
7.	 [528]

•	 Crash when opening some data sources in CS5.	 [529]

•	 Unable to activate the plug-ins if the trial has not 
expired.	 [530]

•	 Character styles located in style groups cannot be used 
in Formatting Tags.	 [532]

•	 The colour attribute in the <font> tag does not recognise 
colours with spaces in their names when applying 
formatted text.	 [541]

•	 Fields in table headers and footers are being shown 
as ‘in error’ if they are in a header or footer that is not 
displayed due to the ‘skip first’/’skip last’ row attribute.

	 [549]

•	 When populating a Product Style, any Field Specifiers/
Fields that are in hidden conditional text will not be 
populated.	 [550]

•	 Recomposition issue after ‘Restrict Vertical Merging to 
Page Bounds’.	 [551]

•	 Cleansing behaves differently on Mac and Windows 
machines. Windows version will sometimes ignore the ^ 
regular expression character.	 [552]

•	 Update Page Numbers from book panel is recreating 
custom fields after every document - it should be done 
once at the end.	 [553]

•	 Improved error reporting when downloading an image 
from a URL.	 [556]

•	 Image URLs containing a colon generate an error when 
downloading (Macintosh only).	 [557]

•	 Images containing a trademark character will sometimes 
fail to import images (Macintosh only).	 [563]

•	 Custom field command parser attempts to interpret 
string literals which are outside of custom field function 
parameters.	 [564]

•	 Single quotes inside of string literals for custom field 
function parameters are not being un-escaped.	 [566]

•	 Crash when producing a matrix table from Relational 
data.	 [569]

•	 Overset text is not always appearing in red in the panel.	
	 [571]

•	 MIN function not working.	 [574]

EasyCatalog Pagination Module
•	 Pagination crashes if all boxes have been deleted from 

the Product Style by actions.	 [479]

•	 ‘Prevent Break’ inserts a break character even when the 
Product Style has been inserted as the first item on the 
page, resulting in an unnecessary blank page.	 [480]

•	 ‘Use Next Position if Item Doesn’t Fit’ not working when 
‘Collision Detection’ is turned off.	 [481]

•	 If an invalid ‘Position Index’ is encountered during 
pagination, InDesign will crash.	 [487]

•	 The ‘Show/Hide’ action doesn’t work with text boxes. 
	 [522]

•	 The ‘Ungroup’ Pagination Rule will sometimes cause 
pagination to stop with the error ‘One or more objects 
would move off the pasteboard’. 	 [524]

•	 The ‘Ungroup’ Pagination Rule is not always processing 
all of the groups (e.g. when a group contains sub 
groups). 	 [525]

•	 A ‘field not found’ error may occur when evaluating a 
Pagination Rules Action when using a Relational Data 
Source. 	 [527]

•	 ‘Update Furniture’ should ignore the contents of table 
header and footer rows. 	 [544]

•	 ‘Update Furniture’ not always sorting the first and last 
items on the page correctly. 	 [554]

•	 ‘Update Furniture’ sometimes uses the last item on the 
previous page instead of the first item on the page. 	 [559]

•	 Fit box to text sometimes leaves the box overset. 	 [562]

•	 Position-based pagination will sometimes add blank 
pages to the document when inserting new pages. 	 [577]
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•	 Position-based pagination should use section page 
numbers. 	 [576]

•	 Progres bar on master-based pagination sometimes 
shows too many steps when the panel is grouped. 	 [575]

EasyCatalog Relational Module
•	 ‘Unable to access resource’ error when displaying the 

Relational configuration dialog for the first time. 	 [561]
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Version 4.0.5 / 5.0.3	 25 August, 2010

Enhancements
EasyCatalog
•	 Added support for context menu in data panels.  User 

can now right-click when over a data panel to show 
a context-sensitive menu. Macintosh users can also 
CTRL-click to show the context sensitive menu. 

•	 Insert Field Specifier, Field Options and Group all 
behave in the same manner as the data panel’s pop-
out menu.

•	 Hide Field: Hides the field from view
•	 New Custom Field: Creates a new field in the panel.  

The content of this field can be calculated using a 
series of new inbuilt functions.

•	 Reorder Columns Alphabetically: Reorders the 
columns in the panel alphabetically by name,

•	 Show Image Search Paths: This option will open a 
browser-based report showing the paths EasyCatalog 
will look to find the image for the selected field.

•	 Update All ‘...’ Fields in the Panel will update only the 
named field in the panel

•	 Update All ‘...’ Fields In The Document will update only 
the named field in the document.

•	 Fields can now be created in EasyCatalog using the 
‘New Custom Field’ option on the right-click menu.   
The value of a custom field can either be calculated from 
the contents of other fields or used to provide summary 
information for groups of records.

•	 Added tool-tip support to the main data panel.  User 
can now hover over a field to show a tool-tip containing 
more of the field content.	 [309]

•	 The ‘Record Viewer’ panel will now search the contents 
of all fields rather than just the key field value.	 [335]

•	 InDesign’s fitting and alignment options specified 
through the ‘Object→Fitting Options’ dialog are now 
applied when importing images.	 [341]

•	 If picture offset fields have been specified on the 
Field Options→Picture Content  panel, they will now be 
updated as part of the ‘Update Panel’ operation.	 [415]

•	 New keyboard shortcut for ‘Update Document With Panel 
Selection’. This can be specified in InDesign’s keyboard 
shortcut editor.	 [367]

•	 Changes to Field Options:
•	 Regular expressions used in cleansing field option 

now support back references:
REGEX:^^(..)(....)=\1.\2.;

		  [340]

•	 Added support for empty filename extensions when 
multiple extensions are specified: 

jpg;eps;; 

 	 [443]

•	 A new picture alignment option of ‘None’ has been 
added.	 [341]

•	 Discretionary hyphen has been added to the list of 
characters that are ignored when ‘Ignore White Space 
Changes’ is selected.	 [393]

•	 Additional option added to Field Options → Advanced 
to prevent empty picture fields from being shown as 
‘in error’.	 [434]

•	 Macintosh only: POSIX paths can now be used to 
specify the location of images.	 [464]

•	 New ‘Advanced’ field options have been added to 
prevent a field from being updated during the ‘Update 
Document’ and ‘Update Panel’ operations.

	
	 [390]

•	 ‘Update Panel→With Page Numbers’ now has a new 
option: ‘Collate pages for all grouped records’. This 
collects all pages that records appear on for a given 
group, collates them into a single value and populates 
the nominated field in the entire group.	 [363]

•	 Document report now shows picture paths and link 
statuses.	 [373]

•	 Added support for self-signed HTTPS certificates. 
Currently, all HTTPS certificates will be accepted as 
valid, regardless of whether they are self-signed or not. 
 	 [394]
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•	 Downloading images from a URL:
•	 All images can now be cached in a single folder per 

field.  This allows the URL to be changed without 
rending all image links on the document invalid.	 [395]

•	 Images can now be downloaded from a HTTPS 
address	 [391]

•	 Windows only: Characters that are legal in a URL but 
illegal in a Windows filename are now stripped when 
caching the file locally. 	 [379]

•	 Added confirmation dialog to the ‘Remove Field Markers’ 
operation.	 [396]

•	 A new row type is now available in Table → Row Options: 
rows can now be defined as header rows, footer rows or 
rows that are inserted ‘once per group’.  The content of 
group header rows is now ignored when processing the 
column deletion option, so if the column is empty but 
the header row contains a value it will be deleted. 	 [466]

•	 Added new keyboard shortcut ‘Auto fill tables’.  This new 
function will inspect an InDesign document table and 
attempt to populate it with data from the panel.

	
In this example, a document table has been pre-filled 
by the user with stock codes. Although the remaining 
columns are empty, these could also be populated with 
data.  This data will be updated to the latest values from 
the panel after performing the ‘Auto fill tables’ operations.

EasyCatalog uses the table column headers to identify 
the fields to insert into the table cells.  This new function 
will either update all tables in the document or only the 
selected table cells.

•	 The field name column in the Record Viewer panel is 
now resizable.	 [459]

•	 Support has been added to specify proxy server and 
HTTP authentication details for downloading images 
from a URL.  These settings can be found in the 
application’s general preferences. 	 [456]

•	 ‘Adopt Fields’ is now also available on the book panel 
menu.	 [442]

•	 Added ‘Update Panel → With Page Positions’. This will 
update the panel with the X and Y positions of fields in 
the document.  For text fields, the position of the text 
box containing the field is used.	 [374]

•	 The cell finder can now work on a document-wide basis 
(it no longer requires a document selection).	 [347]

EasyCatalog XML Data Provider
•	 The first time a field is added to an XML data source, the 

user now has the option to automatically add all fields 
shown in the ‘Examples’ pop-up.	 [292]

EasyCatalog Pagination Module
•	 Guide-based and Flow-based Pagination only:

New option added to the ‘Paginate’ dialog to 
automatically include page, frame, column or odd/even 
breaks when the contents of a specified field change. 		
	[329]

•	 ‘Update Furniture’ is now an option on the Book panel 
pop-out menu.	 [343]

•	 RGB values can now be specified by the field used 
in the ‘Apply Swatch Named In’ Pagination Rule.  The 
contents of the named field should be in the form:

#RRGGBB

RR, GG and BB should be the hexadecimal value for the 
red, green and blue values.	 [356]

•	 Added new action keyword ‘firstingroup’.  The 
{firstingroup GROUPNAME} action can be used to 
determine if a record is the first within a named group. 
This behaves the same during both drag and drop and 
pagination.	 [354]

ODBC Data Provider
Added support for user-supplied parameters to the SQL 
query that is executed to retrieve the data.
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➀

➁
Parameters are included in the SQL statement inside of 
{{ brackets }}. ➀ The value inside of the brackets is the 
name of the parameter presented to the user; ➁ a default 
value can also be included. 
When the query is executed, the user will be prompted for 
the value of the parameters in the query:

A maximum of four parameters can be specified in the 
query.

Parameters can also be changed on the data source 
‘Information’ dialog. Once the parameters have been 
changed, press the ‘Update’ button to re-execute the SQL 
query to retrieve the new data set.

EasyCatalog Scripting Module
•	 The ‘Update Page Numbers’ scripting call now has an 

optional parameter to specify the name of the field to 
search for.	 [370]

•	 New function call added for master-based pagination.
myDV.paginateUsingMasters(myDoc, 1, “spreads”);

Parameter Description

document The document to paginate into.

page number The page number to start paginating at.

spread/
pages

Specifies whether to paginate spreads or pages.

masterfield
(Optional) Specifies the field containing the 
name of a master page to apply when starting 
pagination on a new page.

breakField
(Optional) When the contents of the specified 
field changes, a new page or spread will be 
started.

	
•	 New function call to get the current panel selection: 

selectedDataView will return the data view with the 
current selection; selectedRecords will return a data 
view containing only the selected records.
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var myEasyCatalog = app.easycatalogObject; 

var myDV = myEasyCatalog.selectedDataView(); 

var myDVSelected = myDV.selectedRecords(); 

		  [439]

•	 Added a new script method on the EasyCatalog object 
to retrieve details of the selected links. The function 
getSelectedLinks returns an array consisting of sets 
of: “data source, key field value, field name”.

var mySelection = myEasyCatalog.

getSelectedLinks(); 

for (index = 0; index < mySelection.length; 

index += 3)

{

alert(mySelection[index + 0] + “-” 

+ mySelection[index + 1] + “-” + 

mySelection[index + 2]);

}

		  [465]

•	 Updated ‘setPginationOption’ call to support the 
new pagination settings: ‘FlowBreakOnField’, 
‘FlowBreakOnFieldBreakType’, ‘GuideBreakOnField’, 
‘GuideBreakOnFieldBreakType’.	 [410]

•	 An optional parameter can now be specified on the 
upatePageNumbers script call to control if fields with 
content are cleared. When this is false, any content in the 
field will be preserved. Default is true, which is the previous 
behavior. 

myDS.updatePageNumbers(myDoc, “all”, “Field”, 

“”, false);

		  [451]

•	 Added a new function, applyConfiguration, to apply 
a configuration by name. 

var myEasyCatalog = app.easycatalogObject;

var myDS = myEasyCatalog.datasources.

item(“FMCONS2.CSV”);

var myDV = myDS.dataviews.item(“FMCONS2.CSV”);

myDV.applyConfiguration(“Indeling”); 

		  [449]

•	 Added a new function, changeKey, to change the 
key fields defined for a data source.  This function will 
not modify document content to reflect the new key 
configuration. 

var myEasyCatalog = app.easycatalogObject;

var myDS = myEasyCatalog.datasources.

item(“EASYCATALOG TEST”);

myDS.changeKey(“ArticleIDName”); 

		  [448]

•	 The file parsed by the exchangeTags  function can 
now use quoted fields.	 [437]

Bug Fixes
EasyCatalog
•	 Field-specified column widths were not being applied to 

tables that are set to be populated horizontally.  	 [461]

•	 Fixes a problem where the selection would sometimes 
jump when the user clicks in a table cell.  	 [467]

•	 When applying a cell style during table population, if 
a paragraph style is specified as part of a cell style it 
will now be applied correctly. If a paragraph style is not 
specified as part of a Cell Style, any paragraph style 
applied to the text in the cell will not be overridden. 
	 [318, 350, 378]

•	 Added missing error message for when the field 
specified by ‘prev’ or ‘next’ keyword could not be found.	
[352]

•	 When not using a shared workspace folder, the 
‘Fields.xml’ and ‘Datasource.xml’ configuration files 
will always be written to the workspace folder when 
changes have been made.  	 [358]

•	 If a record cannot be found during the field adoption 
process, the following characters are stripped from the 
beginning and end of the key field value and adoption is 
attempted again: Carriage Return, Line Feed, Tab.  	 [365]

•	 ‘Search for Content’ no longer removes images that have 
been imported for a field. ‘Search for Content’ now only 
removes and re-imports images that were imported 
during a previous ‘Search for Content’ operation.	 [366]

•	 Fixes problem where ‘Fit Box to Content’ operations 
would not work when an anchored item was aligned to 
the bottom of the box.	 [368]

•	 Cell merging now works with horizontally populated 
tables.	 [371]

•	 Fixes unknown exception which occurred when 
attempting to merge cells in a horizontally populated 
table where columns had been deleted due to column 
collapsing.	 [372]

•	 Table cell merging now works when anchored images 
are placed in the table cells.  The path to the anchored 
image is used to determine whether cells are equivalent.	
[375]

•	 When populating tables, ‘Copy and Repeat’ now only 
copies the contents of the selected cells.  To copy the 
entire row (as before), select all cells in the row prior to 
‘Copy and Repeat’.	 [381]

•	 Column collapsing now ignores EasyCatalog group 
header rows.	 [382]
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•	 Fixes cosmetic issues in the localized versions. 
	 [384]

•	 ‘Fit Column to Content’ now also fits the table headers.	
[386]

•	 Fixes ‘unhandled exception in ECProductStyle at line 
1042’.  This was caused by not having the Pagination 
module installed.	 [389]

•	 Fixes problem when running multiple versions of 
EasyCatalog on the same machine and not logged on as 
administrator.  The serial numbers for one version would 
previously be read by the other and marked as ‘invalid.’ 
	 [400]

•	 If a field is overset within a table cell, EasyCatalog 
assumes that it it positioned at the anchor point of the 
table. If the table has split across pages, this anchor 
point could be on a previous page. 	 [401]

•	 Tables contained within field content are no longer 
populated.  This affected users who were using the 
‘imported text’ feature to import text containing a table. 
 	 [398]

•	 When inserting a bulleted/numbered list using the <LI> 
tag, an ‘indent to here’ character is now inserted after 
the tab to ensure the paragraph is correctly indented if it 
splits across lines. 	 [430]

•	 Fixes a problem when loading a panel configuration 
that would sometimes prevent it from being applied 
immediately.  This was a problem where a non-grouped 
configuration was loaded into an already-grouped panel. 
 	 [429]

EasyCatalog Pagination Module
•	 Fixes crash in Master-based pagination when a group 

and a box within the group both have position indexes.		
	 [447]

•	 Minor performance enhancements.	 [348]

•	 ‘Strip Whitespace’ and ‘Remove Blank Lines for Empty 
Fields’ operations are now performed after processing 
anchored items.  This will prevent blank lines or 
whitespace remaining in the document if an anchored 
object deletes itself.	 [423]

•	 Fixes a problem where the progress bar did not always 
appear when paginating a small number of library items 
with a lot of records.	 [351]

•	 When dragging a single record from an ungrouped 
panel to a box that uses the ‘next’ or ‘prev’ keywords in 
a Pagination Rules action, an error would be reported 
(“an error occurred whilst evaluating a pagination rule 
action”).	 [351]

•	 Fixed problems with automatic page insertion:
•	 When the master page consists of multiple single 

column text boxes linked together (instead of one 
multi-column box) pagination would stop with a ‘the 
amount of overmatter was not reduced’ error. 	 [360]

•	 If the first page in the document is even, automatic 
page insertion will sometimes stop when the user 
is using an ‘odd’ or ‘even’ break. This was caused 
by EasyCatalog using the page index number to 
determine if an odd or even page had just been 
inserted.	 [361]

•	 When not paginating at the end of a document, 
automatic page insertion would previously fail.	 [392]

•	 Fixed ‘Unhandled Exception in GuideBasedPagination.
cpp at line 360’. This was caused by attempting to 
paginate onto a master page. 	 [355]

•	 Paginate ‘Group Data’ is now supported for non-
relational data sources.  This can be used in conjunction 
with the ‘Position Index’ attribute to specify which record 
of a particular group to use. 	 [376]

•	 During guide-based pagination, items set to 
‘Continuation’ are now paginated correctly. 	 [377]

•	 Error message given by guide-based pagination was 
showing the page index number in the document, not 
the section page number 	 [402]

•	 When merging using the ‘Restrict Vertical Cell Merging 
to Page Bounds’ option, cells are merged progressively 
smaller from left to right. 	 [404]

•	 Added error message when setting the minimum column 
width to zero on the ‘Column Options’ dialog 	 [405]

•	 Fixes a bug where boxes would be deleted if a postion 
index refered to a group, not a record 	 [407]

•	 Fixes a problem where group header rows could lose 
their content if the first column is deleted as a result of 
column collapsing. 	 [411]

•	 Fixes cosmetic issues in the German-localized version 
on the Pagination dialog.	 [345]

EasyCatalog Scripting Module
•	 The function call ‘setPaginationOption’ now works with 

boolean values correctly.	 [346]

EasyCatalog Relational Module
•	 Fixed problem when using Left/Right joins.  If one of the 

tables in a left or right join does not return a match, the 
data from a previous record may sometimes be used 
instead.	 [357]
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Version 3.0.11 / 4.0.3	 September 14, 2009

Enhancements
EasyCatalog
•	 EasyCatalog documentation and resources can now be 

found on the Help menu.	 [175]

•	 Added an ‘Is Not’ operator to the Subset dialog.	 [278]

•	 Added ‘Is Empty’ and ‘Is Not Empty’ operators to the 
Subset dialog.	 [325]

•	 ‘UPPER’ and ‘LOWER’ are now keywords which can be 
used in options such as field suffix, prefix, picture path, 
etc.	 [283]

•	 A new column option is available to resize the column 
based on the amount of content in the column.  
	 [291]

•	 The width of a table column can now be set based on 
the contents of a field in the data.	 [316]

•	 Added support for the ‘color’ attribute on the HTML 
‘font’ tag.  The colour specified should be the name of a 
swatch defined in the document.	 [317]

•	 Deletion of column/row ‘when fields are empty’ checks 
the contents of text boxes anchored within the cells.	[321]

•	 A ‘DOESNOTCONTAIN’ operator has been added to 
Conditional Processing.	 [304]

•	 A cancel button has been added to the dialog that 
appears warning of the closure of the last panel for a 
data source.	 [302]

EasyCatalog Pagination Module
•	 Added new pagination rule - ‘Apply Swatch From Field’ 

- that will apply a colour swatch to the box based on the 
contents of one of the fields.	 [323]

•	 Added new pagination rule - ‘Apply Object Style From 
Field’ - that will apply an object style to the box based 
on the contents of one of the fields.	 [248]

•	 Added new Pagination Action operands “Is Empty” and 
“Is Not Empty”. 	 [326]

•	 Library items can now be named ‘*’.  When using the 
‘Asset Name’ Pagination option, this wildcard library 
item will be used when a library item with the correct 
name can not be found.	 [307]

EasyCatalog Scripting Module
•	 Scripting operations should now be significantly quicker, 

especially when dealing with multiple data sources or 
configurations where there are a number of available 
data sources.	 [306]

Bug Fixes
EasyCatalog
•	 Fixes crash when attempting to import a text file into a 

graphic frame.	 [74]

•	 During table population, EasyCatalog will no longer 
attempt to apply a cell style if the field is empty.	 [214]

•	 Table columns are now deleted before the application of 
cell styles.	 [215]

•	 ‘Convert to Field Specifiers’ is now highlighted when 
text-on-a-path is selected in the document.	 [244]

•	 The formatting tag <P> no longer affects paragraph 
alignment (unless specified by the tag itself).	 [285]

•	 Fixes bug where a new ‘Fields.xml’ configuration file 
would not be written after a ‘Synchronize with Data 
Source’ that resulted in the number of fields changes.  
This would result in the source data being reloaded each 
time the data source was subsequently opened.	 [285]
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•	 Macintosh only: Fixes problem where image names or 
paths containing accented characters would always be 
reported as ‘in error’.	 [294]

•	 Fixes problem where images would always be shown as 
‘in error’ when placed in non-graphic frames (i.e. if the 
content type was not set to ‘Graphic’).	 [299]

•	 Dragging records to frames that already contain a 
graphic should now be easier.  Previously the user would 
need to drag to white space around the image.	 [300]

•	 Hyperlinks could previously be applied when the field 
type was not set to ‘Hyperlink’.  This would occur if the 
field had previously been configured as a ‘Hyperlink’.	[301]

•	 Importing field options via the ‘Field Options→Import’ 
no longer modifies the key field configuration of the data 
source being imported into.	 [313]

•	 The picture scale import options now work correctly on 
all spreads of the document.	 [315]

•	 The application of a cell style no longer overrides any 
paragraph styles applied to the text within the cell.	 [318]

•	 The ‘fit to content’ table column options should now be 
stored and retrieved correctly.	 [319]

•	 InDesign no longer hangs when attempting to resize an 
empty multi-column text box.	 [320]

•	 An error will now be reported if the group name entered 
into a ‘Group Name’ attribute is invalid.	 [303]

•	 Guide-based and Position-based pagination now work 
correctly when a Product Style deletes itself as the result 
of an action	 [308]

•	 Fixes a potential crash when evaluating Pagination 
Rules actions.	 [310]

•	 Update Panel →With Page Numbers now updates 
records where fields are included in hidden conditional 
text.	 [334]

EasyCatalog Pagination Module
•	 Fixes problem where ‘Last on Spread’ furniture option 

would not always work with Relational data sources.	  
	[287]

•	 Update Furniture no longer displays an error when 
there is no field on the page (or a previous page) in the 
document.  If there is a furniture box on page 1, but the 
first field is on a later page, the furniture box will now be 
populated with data for the first field in the document. 
	[137]

•	 Fixes a problem where pagination would stop if the 
master frame being paginated into contains text.	 [184]

•	 Fixes problem where Position Index would always delete 
boxes when dragging a single group to the document or 
populating a Product Style with a single group.	 [328]

EasyCatalog Scripting Module
•	 Fixes scripting issue where child data sources of 

Relational data sources could not be accessed.	 [282]

EasyCatalog Relational Module
•	 Fixes memory leak when paginating a Relational data 

source.	 [298]
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About 65bit Software

65bit Software Limited was founded in 2003 and specializes in the development of high quality Plug-ins for Adobe InDesign 
and InCopy. 

We believe that the growing processing power of today’s desktop computers is allowing the development of a new breed of 
tools, offering levels of integration, power and ease of use previously only seen in high end publishing systems. 

At 65bit we are committed to providing best of breed solutions for the database publishing, catalog, newspaper and 
magazine markets. 

In addition to developing InDesign Plug-ins, we offer custom development services and can help you to design and 
implement an InDesign or InCopy-based solution. You can learn more about our services or submit a request for more 
information by sending an email to sales@65bit.com 

DAM/System Vendors - Any of our products can be included and branded as part of your solution. Please contact 
sales@65bit.com for more information. 

Contact Details

Postal: Meriden House 
6 Great Cornbow 
Halesowen 
West Midlands 
B63 3AB

Web: http://www.65bit.com

Sales: sales@65bit.com

Support: support@65bit.com 
http://www.65bit.com/support

Twitter: http://www.twitter.com/65bitsoftware

Feedback: We welcome all feedback and 
bug reports on 65bit products. 
Please email any comments to:	
support@65bit.com 


